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Chapter 9: Stacking Strength 

Introduction 
As a packaging professional, you'll routinely need to calculate the stacking 
strength of your shipping cases.  The TOPS Pro software uses the McKee 
formula to calculate the stacking strength of a regular slotted container 
(RSC).  This chapter covers the stacking strength function, including the 
following topics: 

 The McKee formula 
 Edge crush test (ECT) 
 Ring crush test (RCT) 
 Calculate stacking strength 
 Stacking strength results 
 Email board combo list 
 Configuration default settings 

 

The McKee Formula 
The McKee formula uses two laboratory tests performed on board 
components – the edge crush test (ECT) and/or the ring crush test (RCT) – 
to derive a box compression strength value.  TOPS Pro adjusts this 
compression strength value (lab compression) with a variety of 
environmental and structural factors to calculate a box performance value. 

 
Important Note 

 

 Even though the McKee formula is a generally 
accepted design formula, the packaging engineer is 
ultimately responsible to evaluate the degree to which 
this formula might apply and perform the physical 
tests to assure safety. 
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The McKee formula is defined as follows:   

(FC) × (ECT) × (BP).4924 × (Caliper).5076 

Lab Compression = [(FC) × (ECT) × (BP).4924 × (Caliper).5076] × (Shape 
Factor) × (Length-to-Width Ratio Factor) × (Horizontal Flute Factor) × 
(Printing Factor) 

Box Performance = (Lab Compression) × (Flap Gap Factor) × (Humidity 
Factor) × (Storage Time Factor) × (Pallet Spacing Factor) × (Interlock 
Factor) × (Overhang Factor) + (Product Support) 

The abbreviated components in the formula are outlined below: 

 FC = Flute Constant (5.87) 

 ECT = Edge Crush Test 

 BP = Box Perimeter 

 Overhang Factor = 1 – [minimum of (square root of overhang) x 
32.25 ÷ 100, 1] 

Note:  The next three values – Horizontal Flute Factor, Shape Factor and 
Printing Factor – are defined and adjusted in the TOPS Configuration 
program.  For more information, please refer to Chapter 14, Configuration. 

 Horizontal Flute Factor (HFF) = 1, unless non-vertical flute is 
selected.  If non-vertical flute is selected, TOPS Pro looks at HFF for 
the specific board grade.  However, there is no generally accepted 
industry standard for how much a non-vertical flute's compression will 
degrade.  TOPS Pro currently ships with a HFF of 0.9 for a 10 percent 
reduction. 

Note:  To adjust HFF, open the Definitions menu and select Board 
Combinations. 

 Shape Factor = Table lookup based on the proportions of the box – 
relative to box depth – and dimension vertical.  To adjust the shape 
factor, open the Definitions menu and select Box Design Factors. 

 Printing Factor = Table lookup based on printing type and quantity.  
To adjust the printing factor, open the Definitions menu and select Box 
Design Factors. 

 Product Support = Additional support to the overall stacking strength 
provided by the products inside the shipcase. 
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For all other factors, TOPS Pro looks up the value in the table of 
environmental factors, in the Configuration program.  Other factors, which 
the McKee formula does not account for, include rough handling, 
transportation conditions, workers sitting on the box, die cuts, adhesive 
additives, etc. 

Edge Crush Test 
Box compression strength is a matter of structural mechanics.  
Engineering formulas have been developed using various relationships to 
predict compression strength.  The general formula used here predicts Box 
Compression Test (BCT) value as related to Edge Crush Test (ECT), 
Flexural Rigidity and box perimeter. 

Edge Crush Test, also known as Short Column Test, is measured as the 
pounds of force per inch needed to crush a portion of the sidewall of 
combined corrugated board.  Although not the sole criterion for box 
performance, ECT values are an excellent indicator of Box Compression 
Test values and box performance in most of today's applications. 

Ring Crush Test 
The Ring Crush Test (RCT) measures paper strength – specifically 
stiffness.  RCT has been widely used and has a history of more than 20 
years of data correlated to combined board strength (ECT). 

In the RCT, a strip of paper is placed into a jig that curls it into a short, 
tubular ring.  Pressure is then applied perpendicular to the exposed edge.  
Ring Crush is measured as the pounds of force required to crush this 
specimen.  This value has a direct relationship to predicting Edge Crush 
values of the combined board and, ultimately, box compression strength. 

Due to industry-wide improvements in the paper-making process, industry 
average RCT values have gradually increased for a given Basis Weight 
over the years.  However, across the industry, there is substantial variation 
in Ring Crush for a given Basis Weight – from different paper mills, even 
from different paper machines within the same mill. 

"High Ring Crush" or "High Performance" linerboard and medium are 
well above the industry average, at the upper end of the industry 
variability range for a given Basis Weight.  Generally, these papers are 
more tightly pressed – thinner/denser/less porous – than those at the 
average or lower end of the range, which gives paper greater strength per 
pound. 
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Calculate Stacking Strength 
In this exercise, you'll perform a shipcase-to-pallet analysis first, then 
calculate the stacking strength.  To calculate stacking strength, start from 
the Control Panel and follow these instructions: 

1. Perform a shipcase-to-pallet analysis and calculate solutions. 

2. At the Analysis View, click on the Strength button on one of the 
panels.  As an option, you can open the Tools menu and select 
Stacking Strength. 

The Stacking Strength dialog box appears, as pictured below. 

 

 
Notice that the dialog box is complete with pre-defined shipcase and 
pallet parameters, which are grayed out (you can't change them). 
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3. At this point, you'll need to make decisions regarding the following 
parameters: 

Note:  Some of these parameters are pulled from the Environment 
Factors dialog box in the TOPS Configuration program.  This dialog 
box is pictured on page 9.7 for easy reference. 

 Storage Time:  Select the target storage time for the unitloads – 
the period of time you expect the unitloads to be stored in a 
warehouse; for example, three months. 

 Humidity:  Enter the humidity percentage that exists in the 
warehouse.  The default is 50 percent; a typical humidity factor is 
85 percent. 

 # of Loads High:  Enter the target number of pallets high the 
unitload can be stacked in the warehouse. 

 Rotation:  Select the rotation to be used for the unitloads.  Use 
these guidelines: 

If the unitloads are columnar (non-interlocked), select None.  This 
rotation yields no degradation in stacking strength. 

If the unitloads are fully interlocked, select All.  This rotation 
yields a 30 percent degradation in stacking strength. 

If the unitloads are partially interlocked – for example, only the top 
two layers – select Some.  This rotation yields a 15 percent 
degradation in stacking strength. 

 Footprint Factor:  If you have multiple unitloads and not all 
shipcases help support the unitload above, specify how many 
shipcases do help support.  Lowering this number reduces the 
number of bottom-most cases that help support the above unitload. 

 Amount of Printing:  Select the amount of printing on the 
shipcases – usually Simple. 

 Type of Printing:  Select the type of printing on the shipcases – 
usually Flexo. 

 High Light:  Select either Color or None to specify whether you 
want the next screen and printouts to appear in color.  If you only 
want to print, select None.   

Note:  This has no bearing on stacking strength. 
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 Calculation Method:  Select the method used to calculate 
stacking strength.  Use these guidelines: 

The Ring Crush method looks up the ring crush values of the 
board combination's liners and mediums, then calculates the edge 
crush test (ECT) value from those values. 

The Edge Crush method uses the exact ECT value typed in for 
each board combination. 

The Kellicut method is an internationally recognized way to 
calculate stacking strength. 

 Dividers:  The Dividers button displays the Dividers dialog box, 
which displays information entered from the ShipCase Parameters 
dialog box.  Use the Dividers dialog box to change the dividers 
parameters. 

Dividers provide a significant increase in stacking strength of your 
shipcases.  For example, a 12-cell divider – if it's made of the same 
cardboard as the shipcase –increases stacking strength by 108 
percent. 

 Options:  The Options button displays the Stacking Strength 
Options dialog box, which allows you to specify which columns of 
information will appear on the Stacking Strength Results report by 
selecting from a listing of board grades. 

For detailed information about the Stacking Strength Options 
dialog box, please refer to Appendix B, Dialog Boxes. 

4. After completing the stacking strength parameters, click on OK.  The 
Stacking Strength Results Screen appears, as pictured on page 9.8. 

5. If you want to print the list of stacking strength options, open the File 
menu, select Print, then select Stack Strength List.  TOPS Pro sends 
the list of stacking strength options to the printer. 

6. If you want to print all the board combinations in the software, open 
the File menu, select Print Database, then select Stacking Strength.  
TOPS Pro sends the list of board combinations to the printer. 
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Environment Factors Dialog Box 
The Environment Factors dialog box, pictured below, allows you to assign 
numeric safety factors to a range of environmental factors.  TOPS Pro uses 
environmental factors to calculate stacking strength. 

Note:  The Environment Factors dialog box is accessed from the TOPS 
Pro Configuration program.   

 

For detailed information about the Environment Factors dialog box, please 
refer to Appendix B, Dialog Boxes. 
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Stacking Strength Results 
Once you've calculated a stacking strength analysis, TOPS Pro displays 
the Stacking Strength Results Screen, as pictured below.  This screen is 
divided into two panes: 

 Stacking Strength Statistics Pane:  This information includes any 
added data related to the stacking strength option and your package 
design. 

 Stacking Strength List Pane:  This pane, the lower section of the 
screen, displays a number of columns that represent the board grades 
selected from the Stacking Strength Options dialog box.  The default 
set of columns is represented in the figure below. 

 
 

             A          B             C     D     E     F     G    H      I    J      K 
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The Stacking Strength Results Screen provides the following stacking 
strength information: 

 (A) At 2 Loads High, bottom case must support 84.33 lbs:  Amount 
of weight that must be supported by a box on the bottom layer of the 
bottom pallet. 

 (B) Board Spacing:  Also known as pallet spacing.  Use these 
guidelines: 

 If this value is less than 0.1 inch, you have tight pallet spacing. 

 If this value is greater than 0.1 inch and less than 3 inches, you 
have normal pallet spacing. 

 If this value is greater than or equal to 3 inches, you have wide 
pallet spacing. 

Note:  The stacking strength factors associated with pallet spacing are 
defined on the Environment Factors dialog box, pictured on page 9.7. 

 (C) Lab Div:  Lab Compression of the divider.  This column appears 
only if you've specified a divider.  To define new dividers, open the 
Definitions menu and select Dividers.  Each divider has a support 
factor that determines the amount of additional support added by the 
divider.  (A support factor of one (1) = no change.) 

 (D) Lab Box:  Lab Compression of the box without the divider.  This 
column appears only if you've specified a divider. 

 (E) Total Lab:  Total Lab Compression.  If you've defined a divider, 
this value is the sum of the divider compression and box lab 
compression; i.e., Total Lab Compression = Lab Compression of the 
divider + Lab Compression of the box without the divider. 

 (F) Box Perf:  Box Performance.  The resulting compression strength, 
which takes into account the environmental conditions you've 
specified. 

 (G) Safety Factor:  Total Lab divided by the weight that must be 
supported by the bottom case. 

 (H) Safety Margin:  The percentage that the box performance exceeds 
the weight that must be supported by the bottom case; i.e., G = (F – A) 
÷ A.  Boards with Safety Margins that are greater than zero are 
highlighted in blue. 
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 (I) Loads High:  How many unit loads it takes to reach the limit (box 
performance) of a bottom-most case. 

 (J) ECT lbs/in:  The ECT of the board.  If the calculation method is 
Edge Crush, this value is the empirical value entered for each board in 
the TOPS Configuration program.  If the calculation is Ring Crush, 
TOPS will calculate the ECT from the Ring Crush Factor (RCF) of 
each board's papers. 

 (K) Cost/1000ft2:  The cost per 1000 square feet as entered into the 
board grade database. 

Now that you've calculated stacking strength options for your analysis, 
you're ready to narrow down the list of options and select the one that best 
meets your needs.  Follow these instructions: 

1. Analyze the list of options and decide how you want to narrow the list.  
For example, you might want to narrow the list to show all options that 
have a safety factor of 4-7 and a compression strength of 550-665. 

2. Click on the Filter button.  The Stacking Strength Filter dialog box 
appears, as pictured below. 
 

 

3. Use the Stacking Strength Filter dialog box to define the filter criteria.  
In this example, enter information in the following fields: 

 Min Compression Str (lbs):  Enter 550. 
 Max Compression Str (lbs):  Enter 665. 
 Min Safety Factor:  Enter 4. 
 Max Safety Factor:  Enter 7. 

Note:  Compression is the recommended filter method because it's the 
most fine-tuned.  For more information about the Safety Strength 
Filter dialog box, please refer to Appendix B, Dialog Boxes. 
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4. After completing the filter criteria, click on OK. 

TOPS Pro identifies all options that match your filter criteria, then 
redisplays the Stacking Strength Results Screen, as pictured below.  
The options that match your criteria are displayed in blue; the options 
that do not match are displayed in black. 
 

 

 
Notice that TOPS Pro has filtered the list of solutions from 421 down 
to five. 

5. To sort the options by a specific criteria, open the Sort menu and select 
a sort option:  Name, Lab Compression, ECT, Cost or Reverse Order. 

TOPS Pro redisplays the Stacking Strength Results Screen with the 
options sorted according to the selected sort option. 

6. After you've selected a solution, print the output. 

Note:  At this time, there is no way to limit the number of columns 
printed or displayed. 
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Stacking Strength Results – Menu 
Options 
The Stacking Strength Results Screen features a menu bar with the 
following menus: 

 File Menu 
 Sort Menu 
 Tools Menu 
 Supervisor Menu 
 Help Menu 

The File, Supervisor and Help menus are identical to the File, Supervisor 
and Help menus that appear on the Control Panel’s menu bar.  For more 
information on these menus, please refer to Appendix C, Menu Options. 

Sort Menu 
The Sort menu provides the following options: 

 Name 
 Lab Compression 
 ECT 
 Cost 
 Reverse Order 

 
The Sort menu allows you to sort stacking strength results by name, lab 
compression, ECT, cost and reverse order. 

To use the Sort function, start from the Stacking Strength Results Screen 
and select a Sort option (for example, ECT).  The Stacking Strength List 
Pane redisplays with the stacking strength results sorted based on the 
selected option. 
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Tools Menu 
The Tools menu provides the following options: 

 Email Stacking Strength 
 Select As Primary Boardgrade 

Note:  The Select As Primary Boardgrade option is not currently active. 

The Email Stacking Strength option allows you to email the Stacking 
Strength Board Combo List to other users.  This function is discussed in 
the next section. 

Email Stacking Strength Combo Board List 
After you’ve calculated stacking strength results, TOPS Pro allows you to 
email the Stacking Strength Board Combo List to other users.  To use this 
feature, start from the Stacking Strength Results Screen and follow these 
instructions: 

1. Go to the Windows Toolbar and open the Tools Menu. 

2. Select the Email Stacking Strength option.  TOPS Pro automatically 
launches your email application, converts the Stacking Strength Board 
Combo List to an HTML file and attaches it to the email. 

3. Send the email to the appropriate users.  TOPS Pro closes the email 
application and returns you to the Stacking Strength Results Screen. 
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Define Stacking Strength Factor for a 
Non-RSC Box 
When defining parameters for a new, non-RSC box, TOPS Pro includes a 
feature that defines stacking strength in relation to an RSC box.  For 
example, you can define stacking strength for the non-RSC box as 80 
percent or 120 percent of the stacking strength of an RSC box.  To use this 
feature, follow these instructions: 

1. Go to the Menu Bar and open the Define Menu. 

2. From the Define Menu, select the Box Styles option.  The Case Styles 
dialog box appears, as pictured below. 
 

 

 
3. In the Strength Factor field, enter a stacking strength factor as a 

percentage.  For example, if stacking strength for this box is 90 percent 
compared to that of an RSC box, enter 90.00. 

4. Complete the remaining fields to define the new box. 

5. After defining the new box parameters, click on the OK button. 

TOPS Pro saves the new box, including stacking strength factor, to the 
database. 
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Configuration Default Settings 
The TOPS Configuration program allows you to define defaults for the 
various stacking strength variables used in the system, including the 
following: 

 Board Combinations:  Adjusts board grades, including changing, 
deleting or marking them unavailable.  Use this option to adjust a 
board's ECT or cost per 1,000 square feet. 

 Flutes:  Adjusts base flutes, such as the default thickness or flute 
constant. 

 Environmental Factors:  Adjusts humidity, storage time, interlock 
and pallet spacing lookup values. 

 Paper:  Adjusts paper ring crush values. 

 Dividers:  Adjusts divider definitions, which reside in the primary 
TOPSWIN program. 

For more information about defining stacking strength default values, 
please refer to Chapter 14, Configuration. 
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